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Basic Concepts

Referencing and Citations
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What is Citation? 

○ Referencing is an acknowledgment of the sources of the 
information, ideas, thoughts, and data that you have used in 
your work. 

○ Referencing requires you to identify the sources in 2 places:

－ In-text citation: in the main body of your text by citing

－ Bibliographic reference: in the bibliography or list of 
references at the end of your work

○ Accurate citation is crucial to the credibility of academic 
writing and research.
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Author-Year Reference System

APA style

In-text citation

Order by author 

name from A to Z
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Bibliographic 

reference



Number Reference System

IEEE style

In-text citation

Order by citation number 

Shown as a number, 

order by appearance 
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Bibliographic 

reference



Citation styles

Be sure to check with your advisor / department / journal publisher to 

determine which style they prefer. 
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You can use a citation manager to make it easier! 
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Comparison of citation managers:
https://libguides.bodleian.ox.ac.uk/reference-management/comparison-tables

https://libguides.bodleian.ox.ac.uk/reference-management/comparison-tables


Introduction, Setup and Layout

Introduction of EndNote

02



10

Library

Full Texts 

Collect References 

Sources: 碩睿資訊

EndNote Web

Sync AI (Key Takeaway) 



EndNote 2025

▪ The latest version: 2025.1

▪ Different installation files for Windows and Macintosh OS. 

▪ System requirements: 
https://support.clarivate.com/EndNote/s/article/EndNote-2025-21-
20-Operating-System-and-Word-Processor-
Compatibility?language=en_US
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https://support.clarivate.com/Endnote/s/article/EndNote-2025-21-20-Operating-System-and-Word-Processor-Compatibility?language=en_US


Download the Installation File

▪ Download path: NTU Library website 

http://www.lib.ntu.edu.tw/en

12

Use NTU’s email ID 

(not including@ntu.edu.tw)

and password to log in

1

2 3EndNote
NTU student ID

http://www.lib.ntu.edu.tw/en


Download the Installation File
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https://download.cc.ntu.edu.tw/

https://download.cc.ntu.edu.tw/


Notifications

▪ Close all Microsoft Office software before installing EndNote.

▪ If you have a previous version of EndNote installed, you should 

uninstall it using “Control Panel” before installing the new 

version.

▪ If you’re on campus, please connect to NTU wifi.

▪ If you’re off-campus, you must log in to 

the NTU SSL VPN service before downloading.

▪ https://ccnet.ntu.edu.tw/vpn/PulseSecure-eng.html
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https://ccnet.ntu.edu.tw/vpn/PulseSecure-eng.html
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Extract File

▪ Extract the EndNote2025_Win file by right-clicking 
on the zip file and selecting “Extract All”

▪ This will result in a folder with the EN22Inst.msi 
and License.dat file inside it. 
Double-click on the .msi file to start the installation. 

▪ Don’t move the License.bat file out of the folder.

Unsuccessful 

installation

NO product key



Select Installation Type

▪ Click “Next” through installation until this step: 
▪ By default, Typical installs only the commonly used filters, a limited 

set of popular styles, filters, and connection files will be installed. 

▪ To install all available files, choose ”Custom” and 
“Entire feature will be installed on the local hard drive.”
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After Installation…

Check Microsoft Office Word’s toolbar

Microsoft Office version: 2021
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Start Using EndNote   (Windows 11)



Create a New Library

19

Library
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Create a New Library



Create a New Library

A New Library in EndNote
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Library 

Window

Layout

Group panel

Search panel

Reference list panel

Summary / Edit

Tool Bar

Hotkey
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Check the location of the library

◆ Each EndNote library has 2 components:

23

ooo.enl ooo.Data
• .enl file stores 

bibliographic 

information 

• Click the .enl file 

to open the 

library

.Data folder 

stores full texts

◆ Both file and folder must be kept together!!!



Check the location of the library

• Library should be saved to a local drive only.

• Do not save the library to cloud storage 

(e.g., iCloud, OneDrive, Google Drive, Dropbox, etc.)

24 • https://guides.library.uq.edu.au/tools-and-techniques/EndNote-referencing-software/backup-and-cloud-storage

• https://support.alfasoft.com/hc/en-us/articles/360001311578-Storage-location-for-EndNote-libraries

https://guides.library.uq.edu.au/tools-and-techniques/endnote-referencing-software/backup-and-cloud-storage
https://support.alfasoft.com/hc/en-us/articles/360001311578-Storage-location-for-EndNote-libraries


EndNote Library Backup 
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ooo.enl

ooo.Data

USB Hard drive Laptop / 

Computer



Import new references into your EndNote library

Collect References

03
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Sources: 碩睿資訊

Collect References



Key in Manually
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paper prints, websites, newspaper articles, 

government documents, very old, or unusual references …



Select Reference type 

Selecting different reference types will display 

different corresponding fields.

■ Journal Article: Author, Year, Title, Journal, Volume, 

Issue, Pages.

■ Book: Author, Editor, Year, Title, City, Publisher.

■ Conference Proceedings: Author, Year of Conference, 

Title, Editor, Conference Name, Conference Location, 

Publisher, Volume, Number of Volumes, Pages, Series 

Editor, Series Title, Edition Date. 

■ Electronic Source: Author, Year, Title, Access Year, 

Access Date, Edition, Last Update Date, Type of 

Medium, Label, URL. 
29



Enter the bibliographic information 
into the corresponding fields one by one

30

Nanavaty, P., Alvarez, M. S., & Alberts, W. M. (2014). 

Lung cancer screening: advantages, controversies, 

and applications. Cancer control, 21(1), 9–14.

✔Last name, First name 

✔Enter one name per line

✔Organizational unit names must end with a comma,
e.g., U.S. Department of Agriculture,

Nanavaty, P.

Alvarez, M. S.

Alberts, W. M. 



Enter Manually： Save → Close
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Some journals only have issue numbers; 

you can just leave the volume field blank

Nanavaty, P.

9–14

Nanavaty, P., Alvarez, M. S., & Alberts, W. M. (2014). 

Lung cancer screening: advantages, controversies, 

and applications. Cancer control, 21(1), 9–14.

2014

Lung cancer screening: advantages, controversies

Cancer control

21

1

31



The new reference in the list
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File attachment
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You can attach all the related documents

ooo.Data
Attach up to 45 files
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Sources: 碩睿資訊

Collect References



36

Direct Export

*.enw (EndNote default)

*.ris (EndNote)

*.ciw (Web of Science)

*.nbib (PubMed)

• Export

• Save

• Download

• Send to

• Citation manager

• RIS format…
https://libguides.jcu.edu.au/EndNote/export

◆ Note: this will not download the full-text or PDF.

https://libguides.jcu.edu.au/endnote/export


Direct Export reference from Databases
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Web of Science  (WoS)

Academic Search Complete  (ASC)

PubMed

Google Scholar



Find a database from NTU Library

Web of Science

Browse

Databases
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Web of Science

Enter keywords

SCIE (Science Citation Index Expanded)

SSCI (Social Sciences Citation Index)

AHCI (Arts and Humanities Citation Index)
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1

Web of Science
2

3

4

5

6

7
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7

8
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MAC: In the "Import Option" dropdown menu, 

select “Multi-Filter (Special)”

1

2

3

4

5

6

ciw, ris, enw, nbib…files



Academic Search Complete (ASC) 
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Enter keywords
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1

2 Cite tool icon

3

4

5



Direct Export: PubMed

Enter keywords
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1

2

3
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4

5

6
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Google Scholar
1

2

4 5

3



“Import into EndNote” below each record

“Import into EndNote” below each record
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Find Full Text

▪ EndNote provides the “Find Full Text” function to 
automatically search, download, and attach full texts 

▪ First-time settings

50

- Windows: Edit > Preferences > Find Full Text  
- Mac: EndNote 2025 logo > Settings > Find Full Text 



Preferences → Find Full Text

✓ Check the 4 full text sources
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OpenURL Path: 
https://ntu.primo.exlibrisgroup.
com/discovery/openurl?institut
ion=886NTU_INST&vid=886NT
U_INST:886NTU_INST&

https://ntu.primo.exlibrisgroup.com/discovery/openurl?institution=886NTU_INST&vid=886NTU_INST:886NTU_INST&
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1

2

3

4
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You can copy the URL from instruction page

https://www.lib.ntu.edu.tw/en/node/3996

https://www.lib.ntu.edu.tw/en/node/3996
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After completing the preference setting, 

you can follow the steps to find full text.

• Do not select over 100 articles for “Find Full Text” at a time.

• If you’re on campus, connect to NTU wifi.

• If you’re off campus, make sure to set up VPN.

https://ccnet.ntu.edu.tw/vpn/PulseSecure-eng.html
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EndNote will automatically search the full text for you

EndNote successfully found 

and attached the PDFs

PDFs have not been found.

Try OpenURL Link !
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1

2

3

OpenURL Link

▪ Right-click on the reference without full text.

▪ If you’re off-campus, you must log in to NTU SSL VPN 

✓ OpenURL Link: Access full text via the NTU Library’s link-resolver service.

✓ Open URL: Use the URL in the reference to access the database or publisher’s website.

https://ccnet.ntu.edu.tw/vpn/PulseSecure-eng.html
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Sources: 碩睿資訊

Collect References



PDF Import

Import the bibliography

and full text at once!
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DOI

■ If your PDF has Digital Object identifiers (DOI) on it, after 

importing it, the bibliography information will be imported into 

EndNote Library at the same time. 

■ Allow a single PDF file and multiple PDF files (save in the same 

folder) to be imported

What is DOI? 

A DOI, or Digital Object Identifier, is a 

string of numbers, letters, and symbols 

used to permanently identify an 

article or document and link to it on 

the web. A DOI will help readers easily 

locate a document from the citation. 

DOI will always refer to that article, and 

only that one, and never change.
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PDF Import : a PDF
○ File → Import → File → Import Option: PDF
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EndNote also imports bibliographic information

👉
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PDF Import: Folder of PDFs 

Ｖ

Ｖ
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PDF folders have been imported 

EndNote imported the folder 

structure and the PDFs that 

were in the subfolders.
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No DOI?

→ You need to manually fill in the missing information

Scanned PDF Chinese 中文Without DOI

<file name.pdf>



Manage and organize your EndNote Library and references

Build & Work with a Library

04
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Build & Work with a Library

Groups Tags Find 

Duplicates

Personalized 

Functions



Group Set parent folders

Combine the existing groups by AND / OR / NOT.

Automatically updates based on predefined search criteria; 

new matching references are added automatically.

Combination Group

Smart Group

Custom Group subfolders

EndNote Groups Management

67
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manually classify referencesCustom Group
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Add references to a Group 
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A reference can be assigned to more than one group
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Smart Group Set criteria to automatically classify references
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Smart 

Group

References that contain “baseball” in 

the bibliographic information will be 

automatically classified into this group



Combination Group Combine the existing groups by 

“AND” , “OR” , “NOT” 
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Combination groups are dynamically updated with 

combined references from other custom groups or 

smart groups. 



Group Set : organize your numerous groups

Drag existing groups 

into the Group Set
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Group
Combination 

Group
Smart 

Group

Delete references

Delete:
Remove from Group

Delete:
Move to Trash

since it no longer meets the criteria

76
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Build & Work with a Library

Groups Tags Find 

Duplicates

Personalized 

Functions



Tags: another function to classify references
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Drag

Tags: allowing for quick visual scanning

Highlight one or more references while pressing 

command (macOS) or ctrl (Windows) 



Manage Tags

80

1

2
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Build & Work with a Library

Groups Tags Find 

Duplicates

Personalized 

Functions



Find Duplicates
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1

2

It is crucial to remove duplicates 

before you start writing in Microsoft Word.



If Duplicate Refs are Found, 
They Will Be Displayed Side by Side.

83

3



Find Duplicates: Keep This Record 

84



• EndNote identifies duplicate references 

in a library as references of the same 

reference type with matching Author, 

Year, and Title fields.

Modify the Criteria for Matching Duplicates

1

2

3 4
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Build & Work with a Library

Groups Tags Find 

Duplicates

Personalized 

Functions



Personalized Functions: Rating & Read/Unread

87

Read / Unread
indicate whether the ref. has been read 1-5 Stars

represent the importance

87



Tool: Word + EndNote

Writing Papers with 

Cite While You Write

05



Check EndNote Toolbar
(Cite While You Write, CWYW)

89



Check the CWYW tab. If it is not visible, follow the steps below to fix it:

1. Open the EndNote 2025 file 

(Path: C:\Program Files (x86)\EndNote 2025)

2.Click on “Configure EndNote”

3. Check Word function: File→Options→Add-ins

→EndNote Cite While You Write

90

SHOW or NOT?



CWYW Tab (Mac)

Open the EndNote → EndNote 2025 → Customizer → 

Check “Cite While You Write”
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Writing Papers with Cite While You Write

Insert 

Citation
Cite from 

a PDF
Edit & 

Manage 

Citation

Convert to 

Plain Text 
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Insert Citation



Insert Citation: Select the Ref. 

94

Highlight one or more references while pressing 

command (macOS) or ctrl (Windows) 



Insert Citation: Microsoft Word Document

95



Insert Citation→Insert Selected Citation(s)
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Insert Citation: Style and References
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Insert Citation: Select Another Style 

1

2



Insert Citation → Find & Insert References
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Writing Papers with Cite While You Write

Insert 

Citation
Cite from 

a PDF

Edit & 

Manage 

Citation

Convert to 

Plain Text 
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Cite from a PDF
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1

2
Open the reference 

in a new window

3

4

Cite from a PDF



Cite from a PDF
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Writing Papers with Cite While You Write

Insert 

Citation
Cite from 

a PDF

Edit & 

Manage 

Citation

Convert to 

Plain Text 



Edit & Manage Citation

Attention! 

Do not use 

[delete] or [backspace] key 

to remove or directly edit the 

citations.

When you want to remove or edit citations…

105



Remove Citations

106

1

2

3

4
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107

Formatting: (Author, Year)

Formatting: Author (Year)

Formatting: (Author, Year) → Author(Year)
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Default: (Author, Year)



Display as: Author (Year)

Formatting: (Author, Year) → Author(Year)

1

2



Edit Citations: 

Prefix/Suffix / 

Pages

109

1

2

3

4

16-17

(Dou, 2025, pp.16-17)
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Writing Papers with Cite While You Write

Insert 

Citation
Cite from 

a PDF
Edit & 

Manage 

Citation

Convert to 

Plain Text 



Citations and references inserted from EndNote have 

EndNote field code…

Citations and references 
can not be edited by the Word function 
because of the field code in grey.  

111

Convert to Plain Text (Remove Field Code)



Convert to Plain Text (Remove Field Code)

Citations and references inserted from EndNote have 

EndNote field code…

112

If you send a document with field codes, others can’t read 

the citation without your EndNote library file.

Resolution: Remove the connection between the Word and 

EndNote library by converting the citations to “plain text.”



Convert to Plain Text in Windows & MAC

Windows:
Convert Citations and Bibliography→ Convert to Plain Text

113

Mac: 
Tools→ Convert to Plain Text
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Plain Text

115



Reminder

Original Version 
(with EndNote field code)

New Version
(without EndNote field code)

Convert to 

Plain Text

• A simple MS Word file

• You can use the MS Word 

function to edit it

Keep the original Word document safe!

If you need to use the Endnote 
function to add or delete 
citations, you have to use the 
original Word document

116



⚫ Research Assistant/ Key Takeaway

⚫ Sync 

EndNote Web Account

06



• The brand-new EndNote Web is available only to EndNote 21 and 

2025 customers

o Research Assistant/ Key Takeaway

o Tags 

o Cite While You Write for Google Docs, Word Online118

EndNote Web



4

Create EndNote Web Account

5

1

2

3

119



Research Assistant/Key Takeaway

• A generative AI-powered tool.

• Extracts key insights and 

takeaways from the PDF.

• The key takeaway feature is 

available on:

o EndNote 2025 Desktop

o EndNote Web (Activated 

via sync with EndNote 

2025)

120



1

2

3

4

Research Assistant/Key Takeaway

121
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Synchronize allows you to maintain consistency of library content 

across different computers

Sync

123

EndNote Web

EndNote 2025

EndNote 2025

copy all references in your EndNote 

desktop and online libraries to the other 

library during your first sync

Sync



To Activate Sync Function

124



Apply(A)

Sync Automatically or Manually

125

Sync automatically every 15 

minutes in the background.

Sync starts only 

when clicking 

“Sync Now” button.



Sync

126

EndNote 2025
Sync

EndNote Web



Note of Synchronization

⚫ Before starting to sync the EndNote library, it’s 

suggested to backup your library 

⚫ Do not move or rename your EndNote library files 

after they are synchronized, as this will break the link 

to the Sync target library.

⚫ Sync is designed to work with only one library on a 

given computer. Attempting to sync multiple libraries 

will merge references of both EndNote libraries. 
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Online 

Resources 
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9
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https://www.lib.ntu.edu.tw/en/node/3996

https://www.lib.ntu.edu.tw/en/node/3996
https://www.lib.ntu.edu.tw/en/node/3996


13

1

131
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https://www.lib.ntu.edu.tw/en/node/3957

Stay tuned!

https://www.lib.ntu.edu.tw/en/node/3957


https://youtu.be/d4PB65Ks5I0?si=1g90Uv7dbhFu_4Ms

Advanced Features 

133

https://youtu.be/d4PB65Ks5I0?si=1g90Uv7dbhFu_4Ms
https://youtu.be/d4PB65Ks5I0?si=1g90Uv7dbhFu_4Ms


Follow NTU Library 

臺大圖書館
HELP頻道

@ntulib_help

YouTube
LINE

@ntulib

Facebook

@NTULIB

Instagram

ntu.library

https://www.youtube.com/channel/UCuOJd8jfjAdMDAmb0V0OB2g
https://page.line.me/fpq3478y?openQrModal=true
https://www.facebook.com/NTULIB
https://www.instagram.com/ntu.library/

